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;!e‘!c Introduction and workflow overview

A

IMPORTANT! Before using this product, read and understand the information in the “Safety” appendix
in this document.

This guide describes the OpenArray™ plate high-throughput, sample-to-result workflow for urinary tract
microbiota profiling. The workflow uses:

e MagMAX™ DNA Multi-Sample Ultra Kit for DNA isolation from urine samples

e OpenArray" plates with TagMan™ Assays for urinary tract microbiota profiling

* QuantStudio™ 12K Flex instrument with OpenArray™ block (AccuFill™ System)

Urinary tract microbiota profiling

Microorganism-specific TagMan™ Assays offer a rapid and accurate approach to investigate and
monitor urinary tract microbiome composition and dynamics.

We offer a collection of qualified TagMan™ Assays that are optimized for detection of urinary tract
microbes (see “TagMan" Assays for urinary tract microbiota profiling” on page 8). The TagMan™

Assay design and their target sequences have undergone rigorous bioinformatics selection and analysis
to ensure maximum strain coverage and minimal off-target cross-reactivity. Qualified TagMan™ Assays
for urinary tract microbiota profiling demonstrate accurate, reproducible performance in multiple rounds
of testing for sensitivity and specificity. The assays perform well with DNA isolated from urine samples
using optimized MagMAX™ DNA Multi-Sample Ultra Kit protocols.

Additional TagMan™ Assays for microbial targets are available from our predesigned assay collection.
For Custom TagMan" Assays contact QuantStudioFrontDesk@thermofisher.com.

Urinary Tract Microbiota Profiling Experiments Application Guide 5


mailto:QuantStudioFrontDesk@thermofisher.com

Chapter 1 Introduction and workflow overview

L!‘,! Lt!.! ™
Workflow: TagMan ™ urinary tract microbiota profiling experiments

Workflow: TagMan™ urinary tract microbiota profiling
experiments

Collect urine sample (page 12)
v
Isolate DNA from urine research samples using the MagMAX™ DNA Multi-Sample Ultra Kit (page 12)
v
Prepare and run urinary tract microbiota profiling experiments with OpenArray™ plates (page 22)
v

Export and review urinary tract microbiota profiling data (page 35)
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Background and tools for assay
selection

B Ta0MaAN Y ASSAYS . oottt ittt ettt e e e e e e e e e e 7
m TagMan™ Assays for urinary tract microbiota profiling ...................co i, 8
B Oplional CONrols . ... e e 9
m TagMan™ OpenArray™ Plate products and formats ..............c.oiiiiiiiieeiiieaanann. 9
m Configure and order custom TagMan™ OpenArray™ plates ..............c.oviiiniieenn.... 11

TagMan " Assays

TagMan™ Assays for urinary tract microbiota profiling consist of a pair of unlabeled PCR primers
and a TagMan'" probe with a FAM™ dye label on the 5' end and minor groove binder (MGB) and
nonfluorescent quencher (NFQ) on the 3' end.

For more information about real-time PCR and TagMan™ Assays, visit thermofisher.com/
gpcreducation.
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5 Chapter 2 Background and tools for assay selection
TagMan™ Assays for urinary tract microbiota profiling

TagMan " Assays for urinary tract microbiota profiling

All of the TagMan™ Assays for urinary tract microbiota profiling, including the controls, are included in
the TagMan™ Array Urinary Tract Microbiota Comprehensive Plate. The assays can also be configured
with Custom TagMan™ OpenArray ™ Plate (see “TagMan™ OpenArray " Plate products and formats” on
page 9). For optional reference and controls, see “Optional controls” on page 9

For more information about available TagMan™ Assays for urinary tract microbiota profiling, visit
thermofisher.com/utm.

Table 1 TagMan™ Assays for urinary tract microbiota profiling

Assay ID Classification Target organism name
Ba04932084_s1 Bacteria Acinetobacter baumannii
Ba04932088_s1 Bacteria Citrobacter freundii
Ba04932080_s1 Bacteria Enterobacter aerogenes
Ba04932087_s1 Bacteria Enterobacter cloacae
Ba04646247_s1 Bacteria Enterococcus faecalis
Ba04932086_s1 Bacteria Enterococcus faecium
Ba04646242_s1 Bacteria Escherichia coli
Ba04932079_s1 Bacteria Klebsiella oxytoca
Ba04932083_s1 Bacteria Klebsiella pneumoniae
Ba04932078_s1 Bacteria Morganella morganii
Ba04932076_s1 Bacteria Proteus mirabilis
Ba04932082_s1 Bacteria Proteus vulgaris
Ba04932077_s1 Bacteria Providencia stuartii
Ba04932081_s1 Bacteria Pseudomonas aeruginosa
Ba04932085_s1 Bacteria Staphylococcus saprophyticus
Ba04646276_s1 Bacteria Streptococcus agalactiae
Fn04646233_s1 Yeast Candida albicans

(Optional) Control assays!!!
Hs04930436_g1 Control Human RNase P RPPH1 genel?
Ac00010014_af Control Xeno "3

' Included in the TagMan™ Array Urinary Tract Microbiota Comprehensive Plate.
@ Use to assess sample adequacy.
BBl Use to control for nucleic acid recovery in sample preparation process.
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Optional controls

Optional controls

(Optional) TagMan™ Universal DNA Spike In Control

The TagMan™ Universal DNA Spike In Control (Cat. No. A39175) is an exogenous Xeno™ DNA process
control that can be used to monitor the recovery efficiency for the DNA extraction and purification
process. The control also indicates the presence of PCR inhibitors in molecular detection workflows.
This control is of particular importance when working with urine samples that can have a higher
frequency of inhibition.

This product contains a sequence for AmpC beta-lactamase and may amplify for any assays designed
to detect this antibiotic resistance target. For example, TagMan™ Assay ID Ba04646128_s1 will amplify
in any sample that contains the TagMan™ Universal DNA Spike In Control.

TagMan™ Universal DNA Spike In Control is supplied at a concentration of 200,000 copies/pL. The
control is added during DNA isolation and is then carried through the remainder of the urinary tract
microbiota profiling workflow. Coupled with the proprietary TagMan™ Assay for the Xeno™ DNA control
(Assay ID Ac00010014_a1), this verification layer helps ensure that PCR results are accurate, and it
reduces the likelihood of false negatives.

For information about TagMan™ Universal DNA Spike In Control, see TagMan™ Universal DNA Spike In
Control Product Information Sheet (Pub. No. MAN0017852).

(Optional) Amplification control

The TagMan™ Urinary Tract Microbiota Amplification Control (Cat. No. A39174) contains a linearized
multi-target plasmid with target sequences for each available urinary tract microbiota profiling assay.
The plasmid also contains target sequences for Xeno DNA and human RNase P RPPH1 genes, for a
general control for the sample preparation process. The TagMan™ Urinary Tract Microbiota Amplification
Control can be included in urinary tract microbiota profiling experiments to verify assay performance
and to help with troubleshooting.

For information about the amplification control, see TagMan™ Urinary Tract Microbiota Amplification
Control Product Information Sheet (Pub. No. MAN0O17753).

TagMan™ OpenArray”~ Plate products and formats

TagMan™ Array Urinary Tract Microbiota Comprehensive Plate
The TagMan™ Array Urinary Tract Microbiota Comprehensive Plate (Cat. No. A39900 ) contains pre-

plated, dried down TagMan™ Assays for urinary tract microbiota profiling. For the complete lists of
assays included with the TagMan™ Array Urinary Tract Microbiota Comprehensive Plate, see Table 1.
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TagMan™ OpenArray™ Plate products and formats

Contents and storage

Table 2 TagMan"™ Array Urinary Tract Microbiota Comprehensive Plate (Cat. No. A39900)

Component

Amount Storage

Plate

TagMan™ Array Urinary Tract Microbiota Comprehensive

1 plate -25°C to -15°C

Custom TagMan™ OpenArray™ Plate products and formats

Custom TagMan™ OpenArray™ Plates contain pre-plated, dried down TagMan™ Assays for urinary tract

microbiota profiling.

Array format Number of assays Maximum number of samples
18 18 48
56 56 48
112 112 24

Note: We recommend at least three technical replicates of each reaction.

Urinary Tract Microbiota Profiling Experiments Application Guide




Chapter 2 Background and tools for assay selection =
Configure and order custom TagMan™ OpenArray™ plates

Configure and order custom TagMan " OpenArray  plates

1. Go to thermofisher.com/order/custom-array.
2. For array type, select TagMan™ OpenArray™ Real-Time PCR Inventoried Assays Format.

3. In the table, click Select to configure a plate with the desired array format.
The Custom Array Configurator screen displays.

4. Enter the custom array name in the Array name text field.

5. Click Import Your Assay List, then upload or copy-paste the assay information:

¢ Under Upload a list of Assay IDs, click Choose File, then select a tab-delimited text file (TXT)
containing Assay IDs.
or

¢ Under Enter a list of Assay IDs, paste the Assay IDs, then click Import Entered List.

6. Follow the on-screen instructions to configure the assays on the plate.

7. (Optional) Click Save Your Array at any time to save the array configuration to your Thermo Fisher
Scientific account.

8. When the plate is configured, click Complete Your Design, then follow the on-screen instructions
to complete the order.
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Compatible sample collection and storage

Collect urine samples using BD™ Vacutainer® urine collection cups and tubes.
* Compatible urine samples:
- Unstabilized urine that is collected in sterile containers (BD™ Cat. No. 364975)
- Urine that is collected and stored in Urine Analysis (UA) tubes (BD™ Cat. No. 364992)
- Urine that is collected and stored in Culture and Sensitivity (C&S) tubes (BD™ Cat. No. 364951)

* (Optional) Store samples according to the instructions provided with the collection container, or use
the following storage conditions:

— Store at 4°C for up to one week.

— Store at -80°C for long-term storage. We recommend storing samples in smaller volumes to
prevent multiple freeze/thaw cycles.
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Chapter 3 Isolate DNA from urine research samples using the MagMAX™ DNA Multi-Sample Ultra Kit ~ [51¥
Contents and storage

Contents and storage

Table 3 MagMAX" DNA Multi-Sample Ultra Kit

Cat. No. Cat. No.
Contents A25597 A25598 Storage

(500 rxns) (2,500 rxns)
Proteinase K 4 mL 5x4mL -25°C to -15°C
PK Buffer 96 mL 5x 96 mL

15°C to 30°C

Multi-Sample DNA Lysis Buffer 100 mL 5% 100 mL
DNA Binding Beads 8 mL 5x8mL 2°Cto 8°C
RNase A 2x1.25mL 10 x1.25mL -25°C to -15°C
Nuclease-free Water 100 mL 5x 100 mL
Wash Solution 1 Concentratel'] 80 mL 5 x 80 mL
Wash Solution 2 Concentratel'! 162 mL 5 x 162 mL 15°C to 30°C
DNA Elution Buffer 1 25 mL 5x25mL
DNA Elution Buffer 2 25 mL 5x25mL

[l Before use of the kit, prepare all applicable wash solutions as described on their bottles and in this protocol.

Required materials not supplied

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Table 4 Required materials and equipment not included with the kit

Source
KingFisher™ Flex Magnetic Particle Processor 5400630
Equipment
Plate shaker, capable of shaking plates at a minimum of 900 rpm 88880023

Analog Vortex Mixer

Fisher Scientific

02-215-365
Adjustable micropipettors MLS
Multi-channel micropipettors MLS
(Optional) Magnetic Stand-96 AM10027

Urinary Tract Microbiota Profiling Experiments Application Guide
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=88  Chapter 3 Isolate DNA from urine research samples using the MagMAX™ DNA Multi-Sample Ultra Kit
Required materials not supplied

ltem Source
Plates and combs
Deep Well Plates, one of the following:
KingFisher™ Flex Microtiter Deep-Well 96 plates, sterile 95040460
MagMAX™ Express-96 Deep Well Plates 4388476

Standard Well Plates, one of the following:

KingFisher™ 96 KF microplates 97002540

MagMAX™ Express-96 Standard Plates 4388475

Tip Combs, one of the following:

KingFisher™ 96 tip comb for DW magnets 97002534

MagMAX"™ Express-96 Deep Well Tip Combs 4388487

Other consumables

MicroAmp™ Clear Adhesive Film 4306311
RNase-free Microfuge Tubes (2.0 mL) AM12425
Conical tubes (15 mL) AM12500
Conical tubes (50 mL) AM12502
Aerosol-resistant pipette tips MLS
Reagent reservoirs MLS
(Optional) Paraffin film MLS
Reagents
Ethanol, 200 proof (absolute) MLS
Isopropanol, 100% (molecular grade or higher) MLS

Table 5 Additional materials and equipment required for processing urine samples

Item Source

Centrifuge, capable of spinning deep-well plates at 2,250 x g Fisher Scientific

75-412-452
Laboratory incubator with slatted shelves, capable of maintaining 65°C MLS
MagMAX"™ Wash Solution 1 Concentrate AM8504
B-PER"™ Bacterial Protein Extraction Reagent 78243
Lysozyme Solution 90082
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Chapter 3 Isolate DNA from urine research samples using the MagMAX™ DNA Multi-Sample Ultra Kit ~ [Pa8e
Procedural guidelines

Table 5 Only for urinary tract (UTM)Additional materials and equipment required for processing
urine samples (continued)

Item Source
Zymolyase Fisher Scientific
ymey 50-444-504
(Optional) TagMan ~ Universal DNA Spike In Control A39175

(Xeno™ DNA control)

Download the KingFisher™ Flex program (if needed)

The program required for this protocol is not pre-installed on the KingFisher™ Flex Magnetic Particle
Processor.

1. On the MagMAX™ DNA Multi-Sample Ultra Kit web page, scroll down to the Product Literature
section.

2. Click A25597_UTM to download the program to your computer.

3. See Thermo Scientific™ KingFisher™ Flex User Manual (Cat. No. N07669) and Bindit" Software
User Manual (Cat. No. NO7974) for instructions for installing the program on the instrument.

Procedural guidelines

IMPORTANT! Arrange plates in the incubator to allow adequate flow around the plate wells, to ensure
that samples quickly reach and maintain the incubation temperature.

* Perform all steps at room temperature (20-25°C) unless otherwise noted.
* Preheat an incubator to 65°C before each use of the kit.

* Use the KingFisher™ Flex Magnetic Particle Processor with 96 Deep-Well Head and 96-well
standard heat block.

* When mixing samples by pipetting up and down, avoid creating bubbles.

* Cover the plate during the incubation and shaking steps to prevent spill-over and cross-
contamination. The same MicroAmp"™ Clear Adhesive Film can be used throughout the procedure,
unless it becomes contaminated.

* |f you use a plate shaker other than the recommended shaker, verify that:
— The plate fits securely on your plate shaker.

— The recommended speeds are compatible with your plate shaker. Ideal shaker speeds allow
for thorough mixing without splashing.

¢ To prevent evaporation and contamination, cover the prepared processing plates with paraffin film
until they are loaded into the instrument.

* Per-plate volumes for reagent mixes are sufficient for one plate plus overage. To calculate volumes
for other sample numbers, refer to the per-well volume and add 5% overage.

* For convenience, you can extend the Proteinase K digestion to 30 minutes.
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28 Chapter 3 Isolate DNA from urine research samples using the MagMAX™ DNA Multi-Sample Ultra Kit
Before first use of the kit

Before first use of the kit

* Prepare the Wash Solutions from the concentrates:

— Add 25 mL of isopropanol to Wash Solution 1 Concentrate (from the kit). Mix the isopropanol
and concentrate, then store at room temperature.

— Add 132 mL of ethanol to Wash Solution 2 Concentrate (from the kit). Mix the ethanol and
concentrate, then store at room temperature.

— Add 70 mL of isopropanol to Wash Solution 1 Concentrate (separately purchased bottle,
Cat. No. AM8504). Mix the isopropanol and concentrate, then store at room temperature.

* Reconstitute the zymolyase with 500 uL of the provided storage buffer (final concentration of
4 U/uL), vortex to mix, then store at —20°C.

For more information, see the documentation provided with the zymolyase.

Set up the sample layout

The sample plate layout provides sample tracking from the 96-well plate used for DNA isolation to the
96-well sample plate CSV file used for import into the OpenArray™ Sample Tracker Software.

Set up the sample plate layout using the CSV file described in the following table.

Note: We recommend at least three technical replicates of each reaction.

Tool Source Description
96-well Sample On the computer on which the OpenArray™ Contains a sample
Plate 1.csvtemplate Sample Tracker Software is installed: layout tab.

C:\Program Files\Applied
Biosytems\Sample Tracking
Utility\examples
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Chapter 3 Isolate DNA from urine research samples using the MagMAX™ DNA Multi-Sample Ultra Kit ~ [#518
Concentrate the samples

Concentrate the samples

1. Gently invert, shake, or swirl the sample contents to ensure thorough mixing of the sample.
2. Following the sample layout, transfer 1 mL of sample to the wells of a deep-well plate.

3. Seal the plate with a clear adhesive film, then centrifuge the plate at 2,250 x g for 15 minutes to
concentrate the samples.

IMPORTANT! There may not be an obvious pellet. If a pellet is visible, be careful not to disturb
the pellet.

After centrifugation, carefully remove, then discard the supernatant.
a. Set a P1000 pipette (or similar) to 900 pL.

Note: We recommend using a manual P1000 multichannel pipette. An electronic multichannel
pipette can also be used at low speeds (<6 on Ranin pipettes).

b. Angle the pipette so that the pipette tips sit at the bend from square to conical in the plate
well.

c. Carefully remove supernatant, then discard.
d. Repeat substep 4b and substep 4c.

e. Visually inspect the samples to ensure that all urine has been removed.
If > 30 pL of urine remains, repeat substep 4b and substep 4c.

Digest the samples with the Preliminary Digestion Mix

1. Prepare sufficient Preliminary Digestion Mix according to the following table.

IMPORTANT! Prepare the Preliminary Digestion Mix no more than 30 minutes before use and
store on ice. Prolonged storage at room temperature can reduce its efficiency.

Component Volume per well Volume per plate
B-PER"™ Bacterial Protein Extraction Reagent 185 L 18.5 mL
Lysozyme Solution 10 pL 1mL
Zymolyase solution (4 U/uL) 5uL 0.5mL
Total Preliminary Digestion Mix 200 pL 20 mL

2. Add 200 pL of Preliminary Digestion Mix to each sample well.
(Optional) If large pellets are present, disperse by pipetting up and down 10-20 times.

3. Seal the plate with a clear adhesive film, then shake at 1,050 rpm for 3 minutes.

Urinary Tract Microbiota Profiling Experiments Application Guide 17
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Chapter 3 Isolate DNA from urine research samples using the MagMAX™ DNA Multi-Sample Ultra Kit
Digest the samples with Proteinase K

4.

Incubate the plate for 15 minutes at 65°C.

IMPORTANT! Arrange plates in the incubator to allow adequate flow around the plate wells, to
ensure that samples quickly reach and maintain the incubation temperature.

During the incubation, prepare the PK Mix (next section).

Digest the samples with Proteinase K

18

1.

Prepare sufficient PK Mix according to the following table, then invert several times to thoroughly
mix components.

IMPORTANT! Prepare the PK Mix no more than 30 minutes before use and store at room
temperature. Do not place PK Buffer or PK Mix on ice, to avoid precipitation.

Component Volume per well Volume per plate
Proteinase K 8 L 0.8 mL
PK Buffer 42 uL 4.2 mL
Total PK Mix 50 pL 5.0 mL

When the incubation with Preliminary Digestion Mix is complete, add 50 pL of PK Mix to each
sample well of the plate.

Seal the plate with a clear adhesive film, then shake the sealed plate at 1,050 rpm for 3 minutes.

Incubate for 15 minutes at 65°C.

IMPORTANT! Arrange plates in the incubator to allow adequate flow around the plate wells, to
ensure that samples quickly reach and maintain the incubation temperature.
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Chapter 3 Isolate DNA from urine research samples using the MagMAX™ DNA Multi-Sample Ultra Kit ~ [58
Set up the processing plates

Set up the processing plates

1. While the samples are incubating at 65°C, set up the Wash, Elution, and Tip Comb Plates outside
the instrument as described in the following table.

Plate ID Plate positionl'] Plate type Reagent Volume per well
Wash Plate 1 2 Deep Well Wash Solution 1 300 pL
Wash Plate 2 3 Deep Well Wash Solution 1 300 pL
Wash Plate 3 4 Deep Well Wash Solution 2 150 pL
Wash Plate 4 5 Deep Well Wash Solution 2 150 pL
Elution Platel?! 6 Standard DNA Elution Buffer 1 30 L

Tip Comb 7 Deep Well Place a tip comb in the plate.

[ Position on the instrument
' The instrument prompts the user to add DNA Elution Buffer 2 to the Elution Plate, after incubation with DNA Elution Buffer 1.

2. (Optional) To prevent evaporation and contamination, cover the prepared processing plates with
paraffin film until they are loaded into the instrument.

Add Multi-Sample DNA Lysis Buffer, Bead/RNase A Mix,
and isopropanol

1. (Optional) If condensation is present at the end of the 65°C incubation, briefly centrifuge the plate
at 1,500 x g for 1-2 minutes.

2. Prepare sufficient Bead/RNase A Mix according to the following table.

IMPORTANT! Prepare the Bead/RNase A Mix no more than 1 hour before use and store on ice.
Prolonged storage at room temperature can reduce its efficiency.

Vortex the DNA Binding Beads at moderate speed to form a uniform suspension before preparing
the Bead/RNase A Mix.

Component Volume per well Volume per plate
DNA Binding Beads 16 uL 1.6 mL
RNase A 5puL 0.5mL
Nuclease-free Water 19 uL 1.9 mL
Total Bead/RNase A Mix 40 yL 4.0 mL

3. Add 125 pL of Multi-Sample DNA Lysis Buffer to each sample.
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2 Chapter 3 Isolate DNA from urine research samples using the MagMAX™ DNA Multi-Sample Ultra Kit
Add Multi-Sample DNA Lysis Buffer, Bead/RNase A Mix, and isopropanol

4. (Optional) Add 10 pL of TagMan™ Universal DNA Spike In Control (Xeno™ DNA control) to each
sample.

Note: For more information about the Xeno™ DNA control, see TagMan™ Universal DNA Spike In
Control Product Information Sheet (Pub. No. MAN0017852).

5. Vortex the Bead/RNase A Mix at moderate speed to ensure thorough mixing, then add 40 pL to
each sample.

If you see that the beads in the Bead/RNase A Mix are settling, vortex the mix again briefly before
continuing to pipette.

6. Add 200 pL of isopropanol to each sample, then proceed immediately to process the samples on
the instrument (next section).
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Chapter 3 Isolate DNA from urine research samples using the MagMAX™ DNA Multi-Sample Ultra Kit ~ [#518
Process samples on the instrument

Process samples on the instrument

1. Select the program on the instrument.

* KingFisher™ Flex Magnetic Particle Processor: A25597_UTM

2. Start the run, remove the temporary paraffin plate seals (if present), then load the prepared
processing plates in their positions when prompted by the instrument.

3. Load the sample plate (containing lysate, isopropanol, and Bead/RNase A Mix) at position 1 when
prompted by the instrument.

4. When prompted by the instrument (approximately 30 minutes after initial start):
a. Remove the Elution Plate from the instrument.

b. Add 30 pL of DNA Elution Buffer 2 to each sample well.

IMPORTANT! Add DNA Elution Buffer 2 immediately after the prompt, to prevent excessive
drying of any beads that are still captured on the Tip Comb.

c. Load the Elution Plate back onto the instrument, then press Start.

5. At the end of the run (approximately 5 minutes after the addition of DNA Elution Buffer 2), remove
the Elution Plate from the instrument and seal immediately with a new clear adhesive film.

* (Optional) Eluates can be transferred to a new storage plate after collection.

* If you see excessive bead residue in the wells, place the Elution Plate on the Magnetic
Stand-96 to capture any residue prior to downstream use of the DNA.

IMPORTANT! Do not allow the purified samples to sit uncovered at room temperature for more
than 10 minutes, to prevent evaporation and contamination.

The purified samples are ready for immediate use. Alternatively, store the covered Elution Plate:
* At 2-6°C for up to 24 hours.
® At -20°C or -80°C for long-term storage.
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Workflow: Microbiota profiling experiments with OpenArray™ plates ........................
Required materials for OpenArray™ plate Workflow ..............c.coiiiiiiiiiiieiina ..
Generate 384-well sample plate layouts in the OpenArray™ Sample Tracker Software .........
Set up the PCR reactions in an OpenArray™ 384-well Sample Plate ........................
Set up the AccuFill™ instrument and software ............. ..ot
Transfer reactions to the OpenArray™ plate using the AccuFill™ instrument ..................
Seal the OpenArray ™ plate . .. .........o.uiiii it e e
Run the OpenArray™ plate on the QuantStudio™ 12K Flex Instrument ......................

Check the quality—control images .. ... ot e e

ONE-TIME PrOCEAUIES . . .ottt ettt et e et e et et e et e et e et

This chapter describes how to run profiling experiments with custom OpenArray™ plates using a
QuantStudio™ 12K Flex Real-Time PCR System.

This chapter contains brief procedures. For detailed procedures, see the following documentation.

Prepare and run urinary tract
microbiota profiling experiments
with OpenArray " plates

Document Pub. No.
QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™
. . 4470935
Experiments User Guide
OpenArray™ Sample Tracker Software Quick Reference 4460657
OpenArray™ AccuFill™ System User Guide 4456986
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Workflow: Microbiota profiling experiments with
OpenArray ' plates

Genomic DNA Generate 384-well sample plate layouts in the
(page 12) OpenArray™ Sample Tracker Software (page 25)

v v

Set up the PCR reactions in an OpenArray ™" 384-well Sample Plate
(page 26)

v

Set up the AccuFill™ instrument and software
(page 27)

v

Transfer reactions to the OpenArray™ plate using the AccuFill™ instrument
(page 28)

v

Seal the OpenArray™ plate
(page 29)

v

Run the OpenArray™ plate on the QuantStudio™ 12K Flex Instrument
(page 30)

v

Check the quality—control images
(page 31)

v

Export and review urinary tract microbiota profiling data
(page 35)
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Required materials for OpenArray™ plate workflow

Required materials for OpenArray” plate workflow

Unless otherwise indicated, all materials are available through thermofisher.com.

"MLS" indicates that the material is available from fisherscientific.com or another major laboratory
supplier.

Item Source

Instruments, software, and equipment

OpenArray™ Sample Tracker Software -
QuantStudio™ 12K Flex OpenArray " Plate Press 2.0 A24945
QuantStudio™ 12K Flex instrument with OpenArray™ block (AccuFill™ System) 4471090
Centrifuge, capable of spinning sample plates at 1,000 rpm MLS

Plates and accessories

OpenArray™" 384-well Sample Plates, black 4482221
Biomek " Seal and Sample Foil Lids Beckman Coulter™
(for pre-plating step) 538619
OpenArray™ AccuFill™ System Tips 4458107
QuantStudio™ 12K Flex OpenArray™ Accessories Kitl?! 4469576
Forceps MLS
Reagents
Genomic DNA See page 12
(Optional) TagMan™ Urinary Tract Microbiota Amplification Control A39174

* A39900

OpenArray™ plates with TagMan™ Assays « Custom ordered®

TagMan™ OpenArray™ Real-Time PCR Master Mix 4462164

Ethanol MLS

' Included with the QuantStudio™ 12K Flex Software.

[l Each kit contains thMe items needed to assemble up to 10 plates: 12 lids and plugs, 12 immersion fluid syringes, and 2 carriers. Each
custom OpenArray  plate order is shipped with accessories kits.

Bl See “Configure and order custom TagMan™ OpenArray™ plates” on page 11.
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Generate 384-well sample plate layouts in the OpenArray™ Sample Tracker Software

Generate 384-well sample plate layouts in the OpenArray "
Sample Tracker Software

Before generating 384-well sample plate layouts, see “One-time procedures” on page 32 to complete
the following tasks:

* Set up optimized folder locations and software preferences.
e Download the TPF files for the OpenArray" plates into the TPF Files folder.

1. Using a spreadsheet program, create a 96-well sample CSV file.

a. Navigate to the following folder, then open the 96-Well Sample Plate 1.csvtemplate
that is provided with the OpenArray™ Sample Tracker Software.

<drive>:\Program Files (x86)\Applied Biosystems\OpenArray Sample
Tracker\examples

b. Save As the template as a new 96-well sample CSV file. Save your 96-well sample CSV file in
the Sample Tracker 96-well Input folder.

c. Enter or copy the sample names into your 96-well sample CSV file.
2. Open the OpenArray " Sample Tracker Software.

3. In the Properties screen, select Gene Expression for Experiment Type, then select the
appropriate settings for OpenArray™ Plate and Pipettor.

4. Inthe Samples screen, click Import, then select and import your 96-well sample CSV file that
you created in step 1.

5. In the Sample Mapping screen, confirm that the samples for a single OpenArray™ plate are
assigned to one color.

Note: If necessary, correct the OpenArray™ Plate and Pipettor settings in the Properties screen.

6. In the Sample Mapping screen, click the 384-Well Plate tab, then click Export » Export *.csv.

N

Select 384-Well Plate (for AccufFill), enter a file name, then save the exported file.

Plate layouts for the 384-well sample plates are saved to individual CSV files in the Sample Tracker
384-well CSV Files folder.
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Set up the PCR reactions in an OpenArray™ 384-well Sample Plate

Set up the PCR reactions in an OpenArray "~ 384-well
Sample Plate

IMPORTANT! The 4 x 12 area(s) of the OpenArray" 384-well Sample Plate being filled must match the
area(s) designated in the OpenArray™ Sample Tracker Software for that set of samples.

1. Remove an OpenArray ™ plate from the freezer and set it aside. Allow it to come to room
temperature in its unopened sleeve (~15 minutes).

The OpenArray™ plate must be completely thawed before transferring reactions to it from the
OpenArray™ 384-well Sample Plate created in this section.

2. Gently swirl the contents of the TagMan™ OpenArray™ Real-Time PCR Master Mix to thoroughly
mix. Do not invert the bottle.

3. Following the plate layout designated in the OpenArray " Sample Tracker Software, add master
mix, then DNA samples, to the wells of an OpenArray™ 384-well Sample Plate.

OpenArray™ Plate Format

Component!!! 18 56
Volume per well Volume per well
":'/elti()q(Manm OpenArray™ Real-Time PCR Master 25 L 25 L
DNA sample 25uL 2.5l
Total reaction volume 5.0 uL 5.0 L

' (Optional) Include the TagMan™ Urinary Tract Microbiota Amplification Control. For information about the amplification control,
contact CustomControls@thermofisher.com.

4. Thoroughly mix each PCR reaction by pipetting up and down or by using the "mix" function on a
multi-channel pipette.

5. Seal the OpenArray™ 384-well Sample Plate with an aluminum foil seal, remove the foil flap, then
mark the edges of the filled 4 x 12 area with a pen.

6. Centrifuge the plate at 1,000 rpm for 1 minute.

7. Score the foil along the lines that were marked before centrifuging.
Do not remove the foil from the scored area at this time.

If you make a sample layout error before the AccuFill™ procedure — Repeat “Generate 384-well sample

plate layouts in the OpenArray™ Sample Tracker Software” on page 25 with a corrected 96-well sample
CSV file.
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Set up the AccuFill™ instrument and software

Set up the AccuFill" instrument and software

IMPORTANT! Do not use OpenArray”™ AccuFill"™ System Tips that exceed the expiration date (shown
on the outer box that contains the tip trays).

1. Inthe OpenArray" AccuFill™ software, click Setup and Load.
The Setup Load Information window appears.

O— _
@

@ Use Sample Integration checkbox; select to integrate TPF files and the 384-well sample plate CSV file.

@ Browse button; click to locate and select the 384-well sample plate CSV file. The button is displayed only if Use
Sample Integration is selected.

@ Browse buttons; click to locate and select the TPF files for the OpenArray™ plates that will be placed in the
corresponding Plate Holder Position on the deck of the AccuFill™ instrument. The buttons are displayed only if
Use Sample Integration is selected.

(@) Plate Holder Position corresponding to the position of the OpenArray™ plate on the deck of the AccuFill™
instrument.

2. Configure the Loading Information pane for sample integration using the 384-well sample plate
CSYV file and TPF files.
a. In the Loading Information pane (top section of the window), ensure that the Use Sample
Integration checkbox is selected.

b. Click Browse to the right of the Sample Plate field, then select the 384-well sample plate
CSV file that you generated with the OpenArray™ Sample Tracker Software in the Sample
Tracker 384-well CSV Files folder.

c. Click Browse to the right of the Plate Holder Position of the OpenArray™ plate, then select
the TPF file for the OpenArray™ plate in the TPF Files folder.
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Transfer reactions to the OpenArray™ plate using the AccuFill™ instrument

3. In the Select Samples to Load pane (bottom section of the window), click the corresponding
4 x 12 area of the 384-well sample plate image, then click Next.

The Setup Deck window is displayed.

4. In the AccuFill™ instrument, ensure that:
* Tip boxes and tips are loaded as shown in the Setup Deck window.
* The lids are removed from the tip boxes.
¢ The waste bin in the instrument is emptied.

5. In the Setup Deck window, confirm that the deck is ready:
* Select The tips are configured as shown above.
* Select The Waste Bin is empty.

Transfer reactions to the OpenArray " plate using the
AccuFill" instrument

IMPORTANT! Ensure that the OpenArray " plate is thawed and that the entire plate is at room
temperature.

1. Prepare the items needed to seal the loaded OpenArray™ plate (next section).

Note: The OpenArray™ plate must be sealed promptly after being loaded with the reactions, as
described here.

* Ensure that the QuantStudio™ 12K Flex OpenArray™ Plate Press 2.0 is ready.

e Gather and remove from their packaging the following: an OpenArray™ Lid, plug, syringe with
OpenArray™ Immersion Fluid, and syringe tip.

® Attach the syringe tip to the syringe, carefully push some of the fluid through the tip to remove
air bubbles, then lay the syringe aside.

2. Load the OpenArray " plate and the OpenArray™ 384-well Sample Plate into the AccuFill™
instrument.

e OpenArray" plate—Remove the plate from its sleeve, then place the plate in the appropriate
plate holder position in the instrument.

Ensure that the barcode on the OpenArray™ plate is facing left and the serial number is facing
right.

e OpenArray" 384-well Sample Plate —Place the 384-well sample plate onto the deck of the
instrument, then use forceps to peel the foil from the filled area of the plate.

3. Close the door of the AccuFill™ instrument.

4. In the AccuFill™ software Setup Deck window, select the following confirmations:
* The OpenArray Plate is in the Plate Holder
* Remove foil from the highlighted section of the Sample Plate
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Seal the OpenArray™ plate

Click Load.

As soon as the Remove OpenArray Plate window appears, open the instrument door and remove
the loaded OpenArray™ plate.

Proceed immediately to seal the OpenArray™ plate (next section).

Note: For best results, seal the OpenArray™ plate within 90 seconds of completion of loading to
prevent evaporation.

Seal the OpenArray " plate

IMPORTANT! Throughout this procedure, handle the OpenArray ™ plate and the OpenArray™ Case only
by the edges.

Note: The OpenArray™ Case consists of the sealed OpenArray ™ plate and the OpenArray™ Lid.

1.

Place the newly loaded OpenArray™ plate in the QuantStudio™ 12K Flex OpenArray ™ Plate Press
2.0.

Ensure that the barcode is facing left and the serial number is facing right.

From the OpenArray™ Lid, remove the clear protective film from the inside of the lid and the red
adhesive-protective strip from around the edge of the lid.

o2 o

OpenArray " Lid

@ Protective film on inside of the lid (remove before sealing)

@ Red adhesive-protective strip (remove before sealing)

@ Protective film on the outside of the lid (remove before running)
@ Notched end (align with serial number on plate)

Seat the lid on the OpenArray™ plate with the lid adhesive against the plate.

Engage the press mechanism until the green flashing light changes to a steady green light
(approximately 20 seconds).

Disengage the press and remove the OpenArray™ Case.
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Run the OpenArray™ plate on the QuantStudio™ 12K Flex Instrument

6. While holding the case by its edges, insert the prepared syringe tip into the port in the case, then

carefully inject OpenArray™ Immersion Fluid until the case is filled.

Note:
. Minimize creation of air bubbles when you dispense the fluid.

. Leave a small bubble at the fill point to prevent fluid leaks during the instrument run.

The syringe tip must be in front of the array when filling the case with immersion fluid.

While holding the case vertically, remove the syringe tip, insert the screw end of the OpenArray™
plug into the port of the case, then rotate clockwise until the black handle breaks off.

IMPORTANT! To avoid leaking of immersion fluid, hold the case vertically and rotate the plug
slowly.

If the plug handle breaks off prematurely, use a Phillips #0 screwdriver to complete this step.

If needed, clean the case with a laboratory wipe that has been thoroughly sprayed with ethanol,
then dry the case with a clean laboratory wipe.

Run the OpenArray plate on the QuantStudio™ 12K Flex
Instrument

You can run up to four OpenArray™ plates at one time on the QuantStudio™ 12K Flex Instrument.

1.

30

On the QuantStudio™ 12K Flex Instrument touchscreen, touch [ to extend the instrument tray
arm.

Remove the clear protective film from the outside of the OpenArray™ case (sealed plate + lid).

Place the OpenArray™ case on the tray arm plate adapter.

* Support the case from underneath the tray arm to prevent the case from slipping through the
adapter.

¢ Ensure that the plate barcode and serial number are facing the front of the instrument.

Touch g to retract the instrument tray arm.

Urinary Tract Microbiota Profiling Experiments Application Guide



10.

11.

12.
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Check the quality—control images
In the ﬁ Home screen of the QuantStudio™ 12K Flex Software, in the Run pane, click OpenArray.
In the Select Instrument pane, select your instrument.

Click Get Plate IDs to import the barcode of the OpenArray ™ plate.
Once the OpenArray " serial number appears, the loaded TPF file corresponding to the plate
should appear in the Setup File field.

If the TPF file does not appear, click Browse, then select the correct loaded TPF file from the
Loaded TPF folder.

(Optional) Click Browse to change the Experiment File Location.
(Optional) Change the software-determined Experiment File Name.

Click Start Run.

Note: The instrument pauses at 41 or 42 seconds prior to the end of the run. Wait for the system
to complete the run before opening the EDS file.

Transfer the EDS file from the instrument to an accessible location for analysis.

Check the QC images for loading issues or leaks.

Check the quality—control images

Check the quality—control (QC) images before analysis. Images can be viewed using Imaged, an
open-source software available from the NIH at imagej.nih.gov/ig. For additional information, see
Appendix A, “Troubleshooting”.

1.

In the QuantStudio™ 12K Flex Software Export screen, click Browse, then create a uniquely-
named folder for the QC images export.

IMPORTANT! Create a new folder for images each time. Exporting a second run to the same
folder overwrites the images.

Click Export QC Images at the bottom of the screen.

View the following ROX ™" image to check for loading quality issues:
¢ POST-READ_CHANNEL_4.tiff

Check the following spotfinding images for leaks or other displaced sample issues.
* s02_c001_t03_p0001_m1_x2_e1_cp#_spotfind.tiff
* s02_c040_t03_p0001_m1_x2_e1_cp#_spotfind.tiff

Note: The “cp#” in the image file name refers to array positions 1 through 4 within the instrument.
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One-time procedures

5. If a problem is found, view the following pre-run spotfinding image to determine whether the issue
existed before cycling:

* s00_c001_t01_p0001_m2_x3_e1_cp#_spotfind.tiff

6. View the following FAM™ images to check for fluorescent abnormalities and to confirm any
problem seen in the spotfinding images:

¢ STAGE2_CYCLE1_CHANNEL_1.tiff
e STAGE2_CYCLE40_CHANNEL_1.tiff

7. Note any abnormalities found, as well as all other potentially relevant information related to the
setup of the run.

One-time procedures

Set up default folders and software preferences

This procedure simplifies the file locations used in the AccuFill™ software.

Set up the default file locations and preferences before using the OpenArray™ AccuFill™" system for the
first time. You must be logged in as an administrator.

1. Create the following four folders in a convenient location on the same computer drive as the
AccuFill™ software:

* TPF Files

* Sample Tracker 96-well Input

¢ Sample Tracker 384-well CSV Files
* Loaded TPF Files

2. (Optional) Copy a template file into the OpenArray ™ Sample Tracker Software folder.

* Navigate to this folder on your computer: <drive>:\Program Files (x86)\Applied
Biosystems\OpenArray Sample Tracker\examples.

* Copythe 96-Well Sample Plate 1.csv template file, which is provided with the
OpenArray”™ Sample Tracker Software.

* Paste the template file into the Sample Tracker 96-well Input folder.
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One-time procedures

3. Inthe OpenArrayTM Sample Tracker Software, select View » Preferences, then enter the following

preferences:
Field Selection
Experiment Type Gene Expression
OpenArray™ Plate Select the OpenArray™ format that will be run most often,
such as Gene Expression — 56.
Pipettor Fixed or Adjustable tip spacing
Import Data Directory Sample Tracker 96-well Input
Export Data Directory Sample Tracker 384-well CSV Files

4. In the AccuFill™ software, select Instrument » Edit Preferences, then:
a. Select Require Sample Integration.

b. Select the folders indicated in this table:

AccuFill™ folder Default folder Folder contents
OpenArray ™ Plate File TPF Files TPF files for the OpenArray ™
Input Folder plates, with assay name and

location

Sample Plate File Folder | Sample Tracker 384-well CSV CSV 384-well sample plate layout

Files files
Loaded OpenArray™ Loaded TPF Files Integrated TPF files generated
Plate File Folder during processing with the

AccuFill™ software.

5. In the QuantStudio™ 12K Flex Software, select Tools » Preferences » OpenArray, then select the
Loaded TPF Files folder for the software Setup Folder.

Note: If the QuantStudio™ 12K Flex Software is not on the same computer as the AccuFill™
software, transfer the loaded TPF files to the computer running the QuantStudio™ 12K Flex
Software.
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Download TPF files

Set up the optimized folder locations and software preferences before downloading TPF files. See “Set
up default folders and software preferences” on page 32.

To download TPF files for custom OpenArray ™ plates, you need the Lot# and the Serial# from the
packaging of each OpenArray™ plate.

1. Go to thermofisher.com/OA-platefiles.

2. From the Select Your Product dropdown list, select TagMan™ OpenArray™ Custom Gene
Expression/Genotyping Plates.

3. Select the desired option for downloading either only the TPF files or both the TPF files and the AIF
files.

4. Enter the Lot# and the Serial#, then click Submit.

Note: The Serial# is case-sensitive.

5. Save the TPF files to the desktop TPF Files folder.

Note: Do not create sub-folders in the TPF Files folder. The software cannot access sub-folders.
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Export and review urinary tract
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Export data

1.

2.

Open an EDS file in the QuantStudio™ 12K Flex Software.

In the Experiment Menu pane, click Export.

Click Load Export Set (bottom of the screen), select GE_export_setting, then click OK.
Select .xIsx from the File Type dropdown list (top-right of the screen).

(Optional) Perform any of the following actions to customize the file export.

* (Click Browse to select a new Export File Location.
* Enter a new file name in the Export File Name text field.

* C(Click the Results tab, then select the content to export.

Click Start Export (bottom of the screen).

If Open file(s) when export is complete is selected, then the file automatically opens. If the option
is not selected, navigate to and open the exported XLSX file.

Prepare exported data for analysis

1.

2.

Open the exported XLSX data file.

Ensure that the barcode, run conditions, and all selected data columns were exported correctly.
Scroll down to the data rows, select the headers and data, then copy-paste into a new worksheet.
Rename the new worksheet Data Table_Run File Name.

(Optional) To combine data from multiple OpenArray™ plates:
a. Insert a Barcode column in the Data Table worksheet to track OpenArray " barcodes.
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Review results

b. Copy-paste the barcode numbers to the appropriate cells in the new Barcode column.

6. Find-replace all "Undetermined" values with an empty cell (no value) in the C column.
This step ensures an exact count of C,; values.

7. Delete rows that do not contain run data.

Review results

Note: These guidelines apply to results from experiments that included three or more technical

replicates.

Note: We encourage testing and establishing your own C,; cut-off value for each assay to achieve high

sensitivity and specificity.

1. Review the exported data for through-hole results that may require special attention.

2. Consider filtering out from analysis through-holes with the following values:

Parame?er to Consider filtering out through-holes if...
examine
Cy Crt>31
Cq Confidence CqConf<0.8

* RNase P (Hs04930436_g1) — acceptable range is 0.7 — 1.0

Amp Score

Amp Score < 1.2

Note: Through-holes with unexpected C,; values can also be identified by reviewing the
Amplification Plot (see page 38).

3. Review through-holes with C,; > 28 and ensure that the C; values are reproducible in all technical

replicates.

Note: C,; = 28 is approximately equal to 1 copy of the target sequence in a reaction.

4. Take note of technical replicates with mean C,; < 25 and a high standard deviation (> 0.5). The data
from these through-holes might require further review.

5. Ensure that at least half of the replicates amplified adequately and pass your review specifications.

6. Use your preferred method to analyze the data.

36
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Fields for reviewing results with pivot tables

To review results using the pivot table feature of a spreadsheet program, you can use the following
settings.

Note: For the "Average of" and "StdDev of" summarizations, use the appropriate source field (C;, Amp
Score, or C, Conf), then choose the calculation type.

Fields to add
Area of pivot table
Target-oriented view Sample-oriented view
Filters — Sample Namel'!
Columns Sample Name -
Rows Target Name Target Name
Values Average of C; Average of C;
StdDev of C4[? StdDev of C4[?
Count of Cy Count of Cy
— Average of Amp Score
— Average of C4 Conf

' To see individual sample results, select the sample from the dropdown list next to the Sample Name header.
@ A Values field will automatically appear in the Column Labels area.
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Troubleshooting

Troubleshoot DNA isolationerrors .......... ... ... ...,
Troubleshoot unexpected Crtvalues .............................
Troubleshoot with cycling and imaging run images (QC images) .....

AccuFill™ instrument plate loading errors ................ccoveun...

OpenArray™ plate assembly and handling errors
Troubleshoot DNA isolation errors

Troubleshoot unexpected C,; values

Observation Possible cause

Recommended action

Unexpected Cyt values in the amplification plot Unexpectedly low Cy values (<
10) — Signal variation or noise

in early PCR cycles

—O

—®

Review ampilification curves,
AmpScore, and Cq
Confidence values.

Consider filtering Cy; values
from analysis.

Compare replicates, if
available.

Repeat the experiment.

Unexpectedly high C; values (
< 28) — Sporadic amplification

@ Expected C,; value (noted in most replicates)
(2) Unexpected Cy value (too low)

Review ampilification curves,
AmpScore, and Cq
Confidence values.

Consider filtering Cy; values
from analysis if < 50% of
replicates amplified at similar
levels.

Repeat the experiment.

38
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Troubleshoot with cycling and imaging run images (QC images)

Troubleshoot with cycling and imaging run images (QC

images)

Many problems with OpenArray™ results can be diagnosed by examining the quality control (QC)
images taken at various points during a cycling/imaging run.

The QC images are fluorescent or reflected light images taken before, during, and after cycling. They
may require adjustment to make image features visible. To view the images, we recommend that you
install the free software program Imaged, which allows you to easily manipulate the images in ways that
other image viewers cannot.

1. In the QuantStudio™ 12K Flex Software Export screen

a. Click Browse to select a uniquely-named folder for the QC images export.

b. Click Export QC Images (bottom of screen).

IMPORTANT! Select a new folder for images each time; exporting a second run to the same
folder overwrites the images.

2. Use ImagedJ to view the images of interest.

To...

View image...

Image description

Confirm the identity of
images within a folder

BARCODE IMAGE.tiff

Reflected light image of the entire
OpenArray ™ plate

Evaluate the loading
quality

PRE-READ_CHANNEL_4.tiff
POST-READ_CHANNEL _4.tiff

Pre- and post-ROX™ dye images

Check for existing
contamination on the
case and/or heated
cover

s00_c001_t01_p0001_m2_x3_e1_cp#_spotfind.tiffl!]

Pre-run reflected light spotfinding
image (used by the software to
determine the location of the holes)

Identify potential leaks
or other contamination

s02_c001_t03_p0001_m1_x2_e1_cp#_spotfind.tiffl!]

Mid-run reflected light spotfinding
image

s02_c040_t03_p0001_m1_x2_e1_cp#_spotfind.tiffl!]

Post-run reflected light spotfinding
image

Look at patterns in the
fluorescent data (for
example, gradients)

STAGEx_CYCLEy_CHANNEL_1.tiff

FAM™ images at a particular cycle
(y) of a particular stage (x) of the
run.

M The “cp#” in the image file name refers to the array position (1-4) within the QuantStudio™ 12K Flex Real-Time PCR Instrument.

3. (Optional) Adjust the images for brightness and/or contrast to make image features visible.

a. Open the image in ImageJ.

b. Select Image » Adjust Brightness/Contrast (or press Ctrl+Shift+C).

c. Click Auto or adjust the sliders until the features of interest in the image are visible.
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AccuFil™ instrument plate loading errors

AccuFill" instrument plate loading errors

Observation

Possible cause

Recommended action

There are empty through-holes

Insufficient sample was added
to the 384-well Sample Plate.

Use proper pipetting
techniques. Ensure that there
are no air bubbles in the
pipette tips after sample
aspiration.

Reaction mix (sample + master
mix) is not at the bottom of the
384-well Sample Plate.

Centrifuge the plate at 1,000
rpm for 60 seconds.

Turn-holes are repeatedly missed

AccuFill™ instrument is aligned
too far to the left or to the
right.

Systematic loading problems
can occur with the AccuFill™
instrument, which indicates

a need for service. For
example, when turn-holes
are repeatedly missed across
multiple subarrays, service

is required. Turn-holes are
where the AccuFill™ instrument
changes direction during
sample loading.

06500650
OO OO OO0
OO OO OO0
OO OO0 OO0
OO OO OO0
OO OO OO0
@@ OO OO0
Q006000

@ Turn holes
QO Start points
@ Stop points

Contact your local field service
engineer.

Entire subarrays are missing

The sample/master mix was
not added to particular wells in
the 384-well Sample Plate.

Visually inspect the plate to
ensure that the wells have
sample/master mix.

Stuck tip mandrel on AccuFill™
instrument may need cleaning.

Contact your local field service
engineer.
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Appendix A Troubleshooting

OpenArray™ plate assembly and handling errors

Observation

Possible cause

Recommended action

Entire subarrays are missing

(continued)

Pipette tip was not loaded on
mandrel.

Contact your local field
service engineer for frequent
occurrences (infrequent
occurrences can be due to a
poorly molded tip).

OpenArray  plate assembly and handling errors

Observation

Possible cause

Recommended action

Case leaks and bubbles inside the case

Improper sealing of the OpenArray™ plate in the
OpenArray™ Case can lead to immersion fluid leaks
or bubble formation inside the case, leading to
uneven heating and imaging throughout PCR and

to poor quality data.

The images above are examples of OpenArray ™
plates that have been affected by immersion fluid
leaks. The images show where leaked fluid has
condensed on the underside of the heated cover

Plate press was not engaged
for at least 20 seconds.

Fully engage the plate press
for at least 20 seconds.

Damaged lid adhesive.

Remove the liner and visually
inspect the lid adhesives for
defects. Ensure that adhesive
is not damaged or warped.

Damaged fill port screw
gasket.

Visually inspect the screw to
ensure that the orange gasket
is present and not damaged.

Damaged fill port screw
assembly. Breaks off too
easily.

The screw may be mis-
threaded: unscrew it and use
a new screw assembly.

Oily lid or case from immersion
fluid overflow.

Wipe off excess overflow of
immersion fluid from the lid,
case bottom, and crevices
with 70% isopropyl alcohal,
using a lint-free cloth (the cloth
included with the OpenArray™
plate is acceptable).

Immersion fluid was exposed
to air for too long.

Do not remove the immersion
fluid syringe cap or draw air
bubbles into the syringe until
you are ready to load.
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Appendix A Troubleshooting
OpenArray™ plate assembly and handling errors

Observation

Possible cause

Recommended action

windows and obscured the view of the through-
holes.

The best image in which to detect leaks is the
s02_c001_t03_p0001_m1_x2_e1_cp#_spotfind.tiff
image. This image is taken at the start of cycling,
which is where most leaks occur. See “Troubleshoot
with cycling and imaging run images (QC images)”
on page 39.

Too large of a bubble inside
the OpenArray" Case after
sealing.

Minimize the size of the bubble
by tilting the OpenArray™ Case
so that the fill port is at

the highest point. Slowly fill
the case with immersion fluid
until only a small air bubble
remains. Attach the screw and
wipe off any excess oil that
may have spilled onto the
case.

Damaged plate press, leading
to uneven pressure.

Contact your field service
engineer if you suspect that
your plate press may be
damaged.

Sample blow-out during the addition of immersion
fluid

The reactions in A12 were
compromised during the
addition of immersion fluid.
Injecting the immersion fluid
too quickly can purge the
sample out of the through-
holes near the fill port. Often
this is caused by the user

not purging the syringe slightly
before use.

Dispense a small amount
of immersion fluid onto a
paper towel before use to
ensure smooth operation of
the syringe.

Evaporation of reaction mixture in through-holes

Too much time elapsed before
the plate was sealed with lid
and immersion fluid. In this
example, the top half of each
subarray was intentionally left
open to the environment to
demonstrate the effect of
evaporation. “Donuts” are a
result of the evaporated fluid in
the though-holes.

Add immersion fluid as soon
as the case is removed from
the plate press to minimize the
likelihood of evaporation, then
seal the case with the lid.
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, see the “Documentation and Support” section in this document.
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Appendix B Safety
Chemical safety

Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with
sufficient ventilation (for example, fume hood).

. Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer
cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by the instrument is
potentially hazardous. Follow the guidelines noted in the preceding General Chemical Handling
warning.

WARNING! 4L Reagent and Waste Bottle Safety. Four-liter reagent and waste bottles can crack
and leak. Each 4-liter bottle should be secured in a low-density polyethylene safety container with the
cover fastened and the handles locked in the upright position.
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Appendix B Safety
Biological hazard safety

Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 5th Edition, HHS Publication No. (CDC) 21-1112, Revised December 2009;
found at:
https://www.cdc.gov/labs/pdf/CDC-BiosafetymicrobiologicalBiomedicalLaboratories-2009-
P.pdf

. World Health Organization, Laboratory Biosafety Manual, 3rd Edition,
WHO/CDS/CSR/LYO/2004.11; found at:

www.who.int/csr/resources/publications/biosafety/Biosafety7.pdf
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Documentation and support

Related documentation

Document Publication Number
Urinary Tract Microbiota Profiling Experiments Application Guide MANO0017750
DNA isolation for Urinary Tract Microbiota Profiling Experiments Quick Reference MANOO017751
OpenArray™ Urinary Tract Microbiota Profiling Experiments Quick Reference MANO0017752
TagMan" Urinary Tract Microbiota Amplification Control Product Information Sheet MANOO017753
TagMan™ Universal DNA Spike In Control Product Information Sheet MANO0O017852
QuantStudio™ 12K Flex Real-Time PCR System: OpenArray™ Experiments User Guide 4470935
OpenArray™ Sample Tracker Software Quick Reference 4460657
OpenArray™ AccuFill™ System User Guide 4456986

Symbols that may be displayed on the instrument, in the
software, or in this guide

Symbol Description Symbol Description
“ MANUFACTURER ] DATE OF MANUFACTURE
REF CATALOG NUMBER (sN] SERIAL NUMBER
(1 CONSULT INSTRUCTIONS FOR USEI[! A CAUTIONI!

' “Documentation and support” on page 46
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Documentation and support
Customer and technical support

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
* Worldwide contact telephone numbers
* Product support information
- Product FAQs
— Software, patches, and updates
— Training for many applications and instruments
® Order and web support

* Product documentation
— User guides, manuals, and protocols

— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/home/
global/terms-and-conditions.html. If you have any questions, please contact Life Technologies at
www.thermofisher.com/support.
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